Content Manager

Software Version 25.2

Kofax Capture Template

opentext"

Document Release Date: March 2021
Software Release Date: April 2025




Kofax Capture Template

Legal notices

Copyright 2008-2025 Open Text

The only warranties for products and services of Open Text and its affiliates and licensors (“Open Text”) are as
may be set forth in the express warranty statements accompanying such products and services. Nothing herein
should be construed as constituting an additional warranty. Open Text shall not be liable for technical or editorial
errors or omissions contained herein. The information contained herein is subject to change without notice.

Adobe™ is a trademark of Adobe Systems Incorporated.
Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.
UNIX® is a registered trademark of The Open Group.

This product includes an interface of the 'zlib' general purpose compression library, which is Copyright © 1995-
2002 Jean-loup Gailly and Mark Adler.

Documentation updates

The title page of this document contains the following identifying information:

« Software Version number, which indicates the software version.
« Document Release Date, which changes each time the document is updated.
« Software Release Date, which indicates the release date of this version of the software.

To check for updated documentation, visit https://www.microfocus.com/support-and-services/documentation/.

Support

Visit the MySupport portal to access contact information and details about the products, services, and support
that OpenText offers.

This portal also provides customer self-solve capabilities. It gives you a fast and efficient way to access
interactive technical support tools needed to manage your business. As a valued support customer, you can
benefit by using the MySupport portal to:

View information about all services that Support offers
Submit and track service requests

Contact customer support

Search for knowledge documents of interest

View software vulnerability alerts

Enter into discussions with other software customers
Download software patches

Manage software licenses, downloads, and support contracts

Many areas of the portal require you to sign in. If you need an account, you can create one when prompted to
sign in.
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Introduction

Kofax Capture integration with Content Manager is designed to meet large, centralized, high-volume
scanning and storage requirements.

Kofax Capture enables you to set up batch processes for documents that are to be scanned. You can
select and extract the appropriate indexes from the scanned documents. The document images and
their respective indexes are then stored within Content Manager for future retrieval, Workflow and
long-term storage requirements.

Kofax Capture uses the Content Manager Software Development Kit (SDK) to access the Content
Manager features.

Kofax Capture uses a COM component to configure the process for a document class/batch class
pair that exports document index data to Content Manager, which is updated using the Content
Manager SDK.

This connector exports images and full-text OCR files to the Content Manager database. Content
Manager comes with the appropriate export connector that can be imported into Kofax Capture.

Document classes can be defined within Kofax Capture. They provide a convenient mechanism for
associating the same group of index fields to multiple form types.

You can define a document class and then add one or more form types to it. Then you can associate
a set of index fields to the document class.

The same set of index fields will be shared across all the form types defined for the document class.

The scope of this document

This document describes the steps to achieve a basic integration between the two products. This
document assumes that Kofax Capture and Content Manager are installed.

There are three components to this integration:

¢ Specify the batch and document index settings to be used for the integration within Kofax
Capture Administration

¢ The process of scanning images and performing Content Manager index validation within Kofax
Capture Batch Manager

¢ The final process of exporting document images to Content Manager and automatically
attaching them to the records created using the Content Manager Control Panel within Kofax
Capture Batch Manager

Content Manager (25.2) Page 4 of 19



Kofax Capture Template

Setting up Kofax Capture

Before attempting to configure document classes for Content Manager or exporting, install these
applications:

» Kofax Capture stand-alone or on a server
¢ Content Manager
The Content Manager client is required for validation or verification and export.

See CM25.2_Spec.pdf for detailed system requirements for Content Manager Kofax Capture
integration.

Export connector installation

The following section contains information about setting up the Kofax Capture for Content
Manager export connector.

For additional information regarding Kofax Capture document classes and index fields, refer to Kofax
Capture Help.

1. Run the Content Manager export connector CM_Kofax_x86.msi on the export computer
2. Start Kofax Capture > Administration

3. Onthe Tools tab, select Export Connectors

4. Click Add to use the Open dialog
5

. Select the file TRIM[numberl].inf in the folder C:\Program Files\Kofax\Capture\Bin and click
Open.

For example, Kofax 11, the file name would be TRIM11.inf.
A dialog with a list of export connectors to choose from appears.
6. Select Content Manager Export Connector and click Install.
A message box displays Registration Complete.
The Content Manager export connector is now available for use with your document classes.
7. Click OK to close the message box
8. Click Close to close the Add Export Connectors dialog
9. Click Close to close the Export Connector Manager dialog
10. On the Kofax button in the top left corner of the Quick Access toolbar, click Exit to close Kofax

Capture > Administration

NOTE: The installation procedure should correctly register all the export connector files.
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However, if, when running a batch process, you see a message such as Unable to find CLSLID
for ProgID tsjASCOCX.TRIMControl, then you will need to manually register the file in the
message. In this example, register the file tsjASCOCX.

Installing the Content Manager Control Panel

Repeat the installation procedure for validation/verification computers that will use the Content
Manager Control Panel.

See Verification / Validation.

NOTE: This step is only required if different computers are used for validation/verification and
export.

Importing Content Manager field types

The Content Manager integration relies upon predefined field types that must be present in your
Kofax Capture database. These field types are part of a sample batch class called Content Manager
Batch Template, which has been provided for your convenience.

Follow these steps to import the fields:
1. Start Kofax Capture > Administration
2. On the Home tab of the toolbar ribbon, click Import.
The Open dialog appears.

3. Selectthe file Content Manager Kofax Template.cab in the C:\Program
Files\Kofax\Capture\Export folder and click Open.

The Import/Export dialog appears and the package is unpacked.
4. Click OK when the message Completed appears

5. Inthe Import dialog, select Content Manager Batch Template from Available Batch
Classes and click Add

6. Select either Do not import duplicates or Replace duplicates with items imported.

The option Do not import duplicates ensures that the work done to date will not be
overwritten.

7. Click Import.
The import progress log appears.
8. Click OK when the import is complete.
The Content Manager Batch Template appears on the Batch tab of the Definitions window.

9. Use Exit on the Kofax button to close Kofax Capture Administration

During the import stage, a number of field types are imported which have a prefix of CM_ to the field
name, for example, CM_title and CM_Date created.
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The description of each field indicates the Content Manager record field that these types refer to. You
can create new fields on your document class that use these imported field types to automatically
pass the contents from the document to the appropriate Content Manager record field.

Defining the location of the scanned image
For Kofax Capture to process scanned images into Content Manager, you need to define a folder.
You can change it when processing a batch.

1. Start Kofax Capture > Administration

2. Inthe Batch tab of the Definitions window, select the Content Manager Batch Template and
click Properties.

The Batch Class Properties dialog appears.

3. Onthe General tab, if the path in the field Image folder is incorrect, type the full path of the
location of the scanned documents or use Browse to select the folder

4. Click OK to save the location and close the properties

5. Use Exit on the Kofax button to close Kofax Capture Administration

Defining a document class

The sample batch class includes a sample document class called Records Manager Document
Template. It represents a common type of document that may be scanned and stored as a record in
Content Manager. It also demonstrates how to use the predefined field types.

You can modify this document class to suit your needs. If you need multiple document classes for
different kinds of records, you can re-import and modify the sample batch and document classes as
many times as you need to.

Guidelines for creating document classes for use with Content Manager

e Each import requires unique names for the batch and document templates (select template,
then press F2); otherwise, the import process overwrites the existing templates

¢ Mandatory fields - every document class that is to be used to create Content Manager records
must have two mandatory hidden fields in addition to the index fields that will be associated with
the documents of this class.

These mandatory fields are CM_RecordUri and CM_Recordld, and each must have a field
type of the same name. The Hidden property of each field must be set to True, and all other
properties should be set to False.

See the first two field entries in the Content Manager document template shown above.

The field references CM_RecordUri and CM_Recordld are case sensitive — you should spell
them exactly as above.

Name changing is not acceptable for mandatory fields.

¢ Index fields - when your document class includes the mandatory fields, you can add other fields
to the document class to automatically pass data entered or captured through Intelligent
Character Recognition at the validation stage to the Content Manager record created for each
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document.

For example, if your document class includes an index field representing a title for the
document, you can have the value of the field automatically sent to the Content Manager
Record Title field when you create the record.

This is particularly useful if the title has been automatically captured from the scanned
document using ICR.

Viewing or modifying the existing index fields
1. Start Kofax Capture > Administration
2. Inthe Batch tab of the Definitions window, expand the Content Manager Batch Template
3. Select the document class, for example, CM Document Template and click Properties.
The Document Class Properties dialog appears.
The existing field type and index fields within the class appear on the General tab.
Click on the field type to change
Click on the column to modify and make your changes

Repeat for each column to modify

N o o &

Repeat for each row to modify
NOTE: Name changing is not acceptable for the field Internal Barcode.

8. When you have completed your changes, click OK to close the properties

9. Use Exit on the Kofax button to close Kofax Capture Administration

Adding a new field type
1. Start Kofax Capture > Administration
2. Inthe Batch tab of the Definitions window, expand the Content Manager Batch Template

3. Select the document class, for example, Content Manager Document Template and click
Properties.

The Document Class Properties dialog appears.
The existing field type and index fields within the class appear on the General tab.
4. Click New Field Type...
5. Type a name, following these instructions:
¢ The field name should be CM_ and then the exact name of the Additional Field.

This is very important. If the name of the field does not match the name of the Additional
Field, it will not work.
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¢ You should ensure that you only use each CM_field type no more than once on each
document class.

The exception to this is the CM_notes field. If you have several document fields using this
type, the contents of each will be passed to the Notes field on the Content Manager record,
where the contents of each field will be preceded by the field name that you have chosen. If
more than one CM_notes field is used, then each must have a unique name.

Fill in the field Description with a description of your choosing
Select a Data Type.

See below for tips on matching data types.
NOTE: You cannot delete a field type once it has been created.

When you have completed your changes, click OK to close the properties

Use Exit on the Kofax button to close Kofax Capture Administration

Matching data types

The Content Manager export connector for Kofax Capture supports all Content Manager
Additional Fields EXCEPT date and time combined fields.

Kofax has a separate data type for date and time.
For Additional Fields of type Decimal or Currency: use DECIMAL or NUMERIC data type.

Ensure the digits and decimal places are equal or less than that set in the Additional Field in
Content Manager (1 to 15 digits, no negative numbers).

For Additional Fields of type Boolean: use VARCHAR data type.
Ensure the data read from the form is either TRUE/FALSE, YES/NO or 1/0.
For Additional Fields of types String or Text: use VARCHAR data type.

Ensure the number of characters is equal or less than the field length set in the Additional Field
in Content Manager (up to 254 characters)

For Additional Fields of types String or Text based on Lookup Sets: use VARCHAR data
type.

Ensure the number of characters is equal or less than the field length set in the Additional Field
in Content Manager (up to 254 characters)

The data read from the form needs to match the case sensitivity of the values in the Lookup Set
exactly or it will not register correctly when the record is created in Content Manager and a
blank value will be used instead.

For Additional Fields of Date: use Date.
For Additional Fields of Number or Large Number:

° use INTEGER - from Kofax: Numeric value with the number of numeric digits equal to 10,
and the number of decimal places equal to 0 The range is -2,147,483,648 to 2,147,483,647.
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© use SMALLINT - from Kofax: Numeric value with the number of numeric digits equal to 5,
and the number of decimal places equal to 0 The range is -32,768 to 32,767.

Adding or deleting index fields

To add or delete an index field, see the Kofax Capture Help file.

OCR

Enabling OCR in the batch process
Some document classes may need to be set up with Optical Character Recognition (OCR) enabled.
Setting up OCR for a document class
1. Start Kofax Capture > Administration
In the Batch tab of the Definitions window, expand the Content Manager Batch Template
Select the document class, for example, CM Document Template and click Properties.
The Document Class Properties dialog appears.
Select the OCR tab
Select Enable OCR full text
Click OK to close the properties dialog
Right-click Content Manager Batch Template and click Properties.
The Batch Class Properties dialog appears.

© © ©® N o g k~ DN

—_

Select the Queues tab

—_
—_

. From Available Queues, select OCR Full Text and click Add to move it to Selected Queues
12. Click OK to close the properties dialog

13. Use Exit on the Kofax button to close Kofax Capture Administration

You can now attach OCR text renditions to a record.

Setting up OCR full text configuration
OCR full text configuration does not work with the default output format.
To changeiit:
1. Start Kofax Capture > Administration
2. Inthe Batch tab of the Definitions window, expand the Content Manager Batch Template
3. Select the document class, for example, CM Document Template and click Properties.
4. The Document Class Properties dialog appears.
5. Selectthe OCR tab.
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13.
14.
15.
16.
17.
18.

Select Enable OCR full text if not already selected

In the Recognition Profiles field, select Kofax Advanced OCR Full Text
Click Edit

The Recognitions Profiles dialog appears.

Towards the bottom of the dialog, click Output...

. The Advance OCR Output Format dialog appears.

In the Output Format field, select Rich Text Format (.rtf), Microsoft Word (*.doc) or
Microsoft Excel (*.xls)

Click OK to close the Advance OCR Output Format dialog

Click Close to close the Recognitions Profiles dialog

Confirm the changes and save your profile

On the Properties window, change the Recognition Profiles field to display your profile
Click OK to close the properties dialog

Use Exit on the Kofax button to close Kofax Capture Administration

Using the batch class

When you are finished with setting up your document classes within the Content Manager batch
class, use the following steps to set up and publish the class:

1.
2.
3.

Set up the export connector for each document class
Validate each document class script

Publish the batch class

Setting up the export connector for a document class

1.

@ o &~ N

Start Kofax Capture > Administration

In the Batch tab of the Definitions window, expand the Content Manager Batch Template
Select the document class, for example, CM Document Template

On the Home tab of the toolbar ribbon, click Export Connectors

The Export Connectors dialog appears.

From the list of Available Export Connectors, select Content Manager Export Connector
and click Add to add it to the list Assigned Export Connectors or click Setup if it is in that list
already.

7. The Content Manager Setup Script dialog appears.

On the Record Manager tab, click Select database to choose the dataset the integration
should use.

The Open Content Manager Dataset dialog appears.
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10.
11.

12.
13.
14.
15.

16.

17.

18.

19.

20.

Select a registered dataset and click OK to close the Open Content Manager Dataset dialog

On the Content Manager tab, click Select record type to choose the default Record Type the
integration should use when creating records from scanned documents.

The Select from Record Types dialog appears.
Only those Record Types set up for electronic documents appear in the list.
Choose one and click OK to close the Select from Record Types dialog

Optional: Check the Use Content Manager Index Fields option to force the integration
component to automatically transfer the values of the Content Manager index fields on this
document class to the created Content Manager record, i.e. those index fields with a type name
prefixed with CM_.

NOTE: If your document class does not use any index fields specified as one of the
predefined CM__types, clearing this option improves performance slightly.

Optional: Select the option Allow user to change to allow the validation users the ability to
change the Record Type when they are creating records, rather than going with the default
Record Type

If this option is not selected, the default Record Type name must be validated by connecting to
Content Manager

Optional: The General section of the Content Manager tab enables the administrator to
determine whether or not the Content Manager control panel will initially be visible to the
validation user.

¢ Choose Automatically invoke Record creation so the control panel will not be visible and
the Create Record dialog will appear automatically.

¢ Choose Show Integration Control Panel so the control panel will be visible, and the
Create Record dialog will appear only when the user clicks Create Record on the control
panel.

Optional: The Event Monitor section enables the administrator to determine whether the event
monitor on the Content Manager control panel will be visible. These options are only available
when the option Show Integration Control Panel is selected.

¢ Choose Show so the Event Monitor is initially visible. The user can hide it.
* Choose Hide so the Event Monitor is not initially visible. The user can display it.
¢ Choose Disable so the Event Monitor is not visible. The user cannot display it.

Optional: The Queues section enables the administrator to choose the batch processing stage
the control panel is used for creating Content Manager records.

* Choose Validation so that the records will be created during the validation stage.
Select this option if the batch will not use the verification stage.
¢ Choose Verification so that the records will be created during the verification stage.

Select this option if the batch will use the verification stage.
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21. Optional: The Record Policy section enables the administrator to determine what options are
available when creating Content Manager records from the documents in a batch.

¢ Choose Allow user to selectively create Records so that no warning appears when the
user does not create a record for each document.

Ensure another option is selected to be prompted to create a Content Manager record.

¢ Choose Warn if Record is not created so that a warning appears when the user does not
create a record for each document.

* Choose Require a Record for every document so that an error message appears when
the user does not create a record for each document and the batch will not be completed
until all records are created.

22. Change to the Document type tab.

23. The Export Images As section enables the administrator to choose the format to save the
exported images as.

24. Forlmage Type, choose one of the following options:
¢ Multipage TIFF - CCITT Group4 - default
¢ Multipage TIFF - CCITT Group3
¢ Multipage TIFF - Uncompressed
e Multipage TIFF - CCITT Group 3/2D
¢ Multipage TIFF - JPEG Compression
* JPG - JPEG Compression
¢ PDF - Multipage TIFF
« Kofax PDF
25. For Export Folder, click Browse, select a folder, and then click OK.
The images will be deleted from this folder after being exported to Content Manager.
The Browse button is not available for Kofax PDF.

e Choose Skip First Page to not export the firstimage in the document, for example,
because it is a separator sheet

¢ Choose Export OCR Full Text to export an additional .txt file with the text that was
scanned and recognized.

This option enables you to index the image text and therefore make it searchable.
26. When your changes are complete, click OK to close the Content Manager Setup Script.
27. Use Exit on the Kofax button to close Kofax Capture Administration

NOTE: Always remember to re-publish your batch class after making changes to the export
connector settings, or they will not be used.
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Validating the document class script

1.

—_

—_
—_

© © ©® N o g kb N

Start Kofax Capture > Administration

In the Batch tab of the Definitions window, expand the Content Manager Batch Template
Select the document class, for example, CM Document Template

On the Home tab of the toolbar ribbon, click Validation Script

The Document Validation Script dialog appears.

Make sure Document classes and Script name are both set to CM Document Template
Click Create to open the editor.

The SBL editor appears.

Click the Check (V) button in the toolbar.

The script should compile without error and it should state in the status bar at the bottom of the
SBL editor that the script compiled successfully.

. Onthe File menu, click Exit to close the SBL editor
12.
13.

Click Close to close the Document Validation Script dialog

Use Exit on the Kofax button to close Kofax Capture Administration

Publishing the batch class

1.

o o &~ w DN

Start Kofax Capture > Administration

In the Batch tab of the Definitions window, expand the Content Manager Batch Template
On the Home tab of the toolbar ribbon, click Publish

The Publish dialog appears.

Click Validate.

This option validates the selected batch class. The validation process runs stringent checks on
your batch class selections.

The results of the validation process appear in the Results box.

There should be 0 warnings and 0 errors.
NOTE: Validating your batch classes is a good way to check your selections as the batch
classes are created. It might be especially useful when you are editing a batch class and are

not ready to make it available for use. You can validate the batch class as you make your
changes to troubleshoot possible problems.

Click Publish.
This option checks the batch class selections and publishes the selected batch class.

The results of the publishing process appear in the Results box.
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There should be 0 warnings and 0 errors.

9. Ifthere are errors, the batch class will not be available to users for creating batches. Correct the
problems and republish.

10. Click Close to close the Publish dialog
11. Use Exit on the Kofax button to close Kofax Capture Administration

After the batch class has been published successfully, new batches can be created based on this
batch class. The setup is now complete.

Validation / Verification

This section describes the use of the Content Manager control panel to interactively create Content
Manager records.

The appearance and behavior of the Content Manager control panel is determined by the settings in
the export connector setup described earlier. Depending on the option you selected during setup, the
control panel may appear in the validation stage or the verification stage.

The behavior described below is the same in either case.

Logging in to Content Manager
1. Start the program Kofax Capture > Batch Manager
2. Onthe Home tab of the toolbar ribbon, click Create.
3. The Create Batch dialog appears.
4. Onthe General tab, choose a batch class.

Content Manager Batch Template should be already selected.

i

In the field Name, type a description of the job, click Save and then click Close.
6. The batch appears in the Kofax Capture Batch Manager window.

7. Onthe Home tab of the toolbar ribbon, click Process

Content Manager Control Panel

If you selected the option Show Integration Control Panel in the Content Manager export
connector setup, then the control panel appears next to the list of index fields.

You can move the control panel to another position or have it float as a window by placing the mouse
pointer just outside the border of the panel and dragging it to a new position. The panel will remain in
the new position in subsequent sessions. You can also hide or show the Control Panel using the
menu command View > Toolbars > Content Manager Control Panel.

¢ Record Number — the Content Manager record number

* Record Type — the Content Manager Record Type to use for new Content Manager records.
Determined by what was selected in the Content Manager Setup Script dialog.
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You can choose a Record Type if the option Allow user to change was selected in the
Content Manager Setup Script dialog.

¢ Select record type - to select a Content Manager Record Type.
Only Record Types set up to use a document store appear in this field.

« Connection Status fields - display information about the connection to the Content Manager
SDK

¢ Event Monitor — select to turn the event monitor on.
The event monitor logs activity that the control panel is performing.
Creating a record for the current document
1. Create Record - displays the Content Manager New Record dialog
NOTE: If you selected the export connector setup option Automatically Invoke Record

Creation, the dialog appears before the document closes, without having to click the button
on the panel.

The integration automatically sends the field values in index fields with a CM__ type to the
corresponding field on the Content Manager record, including those fields that are not
appearing on the Record Creation dialog.

You can add or modify the values on the form using all of Content Manager's standard search
and lookup features.

2. To confirm the details and create the record within Content Manager, click OK.

After the record has been created, the integration saves the record identifier on the Kofax
Capture document and it appears in the Record Number field in the Content Manager control
panel.

The integration also updates the CM__ type document index fields that were modified in the
Content Manager New Record dialog.

NOTE: Limitation - the Content Manager control panel may appear even when not using the
Content Manager export connector. Kofax Capture writes some registry keys when using an
export connector, and does not remove them when using another export connector.

Export

This section describes the export phase and module, which is part of the Kofax Capture product and
is not specific to this export connector.

To execute the export connector:
1. On your computer, click Start and in the Kofax Capture program group, click Export.
The Export screen appears and shows the progress of the process.
If an error occurs during export, a document will only ever be exported once.

Re-processing a batch after quality control does not result in duplicate documents or batches.
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The Content Manager export connector processes the batch by attaching the exported
document image files to the records created during the validation or verification stage.

Configuration for barcode recognition

Many organizations distribute their mail directly to the recipients, without routing it through the
scanning room first.

In this case, the recipients should be able to register their mail in Content Manager, print out a label or
cover sheet for their document and then hand it over to the scanning room later.

These scanning operators do not have to create records in Content Manager any more, but merely
assign their images to the existing records.

The Content Manager export connector makes this process easy; it recognizes record barcodes.

This section describes the configuration of the export connector for this type of operation.

Export setup steps

You can use the Content Manager Setup Script dialog to configure the export connector to never
present the scanning staff with a Content Manager New Record form when all barcodes are valid
Content Manager records.

1. See Export setup on how to show the dialog
2. Select the Content Manager dataset and default Record Type

3. Select the options:
¢ General - Automatically invoke Record creation

* Queues — Validation
¢ An option under Records Policy

¢ Animage type in the Document Type tab

Export setup steps

Delete this text and replace it with your own content.

Index field setup

The Content Manager barcode must be scanned to an index field on the document class called CM_
Internal Barcode.

This field must be of the type CM_Internal Barcode. The index field and field type are part of the
sample Content Manager batch class import.

To create the field type manually, make it a field of the type VARCHAR with a length of 10 characters.

The CM_Internal Barcode field is the only field that you need to configure in addition to the fields
CM_RecordUri and CM_Recordld because the record's metadata has already been created by the
mail recipient.
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Configuring the barcode area as an indexing zone

For Kofax Capture to read the barcode into the CM_Internal Barcode indexing field, you need to set
up an indexing zone:

1. Create a sample page by right-clicking the form type and clicking Add Sample Pages
2. Select a .tif file to be the basis of the page, click OK
3. Select the sample page you have created and click Create Index Zone in the toolbar at the top

4. Inthe page area, click and drag to select the area where the barcodes are attached to the
documents or located on the cover sheet

The Create Index Zone dialog appears.
5. In Associated field, select CM_Internal Barcode

6. Select Auto recognition and in Recognition profiles, select Kofax 3 of 9 Bar Code and click
OK

7. Right-click your batch class, click Properties and in the Queues tab and make sure that
Recognition Server is in the list Selected Queues on the right

8. Publish your batch class

Executing the record barcode recognition script

The above configuration reads the barcode in the indexing zone during the recognition queue
execution and transfers the value of the barcode as text to the Internal Barcode field in Content
Manager.

At validation time, the Content Manager export connector recognizes the presence of the Internal
Barcode field and, rather than presenting a New Record form, it searches for the record with the
same barcode.

If it finds the record, it stores its URI and record ID so that it can export the image against that record.

If it does not find a record with that barcode, it displays a message and then provides the operator
with a Content Manager New Record form.

Itis a good idea to display the barcode field to the operator so that they can check that Content
Manager has recognized a valid code, i.e. an R followed by nine digits and the database identifier.

To make the process even easier, the Content Manager barcodes could be printed with the code in
plain text below the barcode.
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Kofax Capture Template

Technical support

Kofax Capture resellers are responsible for providing first level technical support directly to their
customers.

To obtain technical support for the export connector or to report software errors, please contact your
Kofax Capture Reseller (ACR).

Prior to contacting support, please ensure you have completed the following steps:
* You have read this document
¢ You have installed and set up Content Manager
¢ You have installed and set up Kofax Capture
¢ You have installed and set up the Content Manager export connector

¢ You have recorded and trapped all error messages in the Kofax Capture error log

Feature requests
This export connector has been designed to meet the majority of customer requirements.

Feature requests should be sent to Kofax through your Kofax Capture reseller.
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